Parameétrer GitLab dans Rstudio

Dans Rstudio, un projet = un repo.

En HTTPS via un token

Créer un nouveau projet dans Rstudio : File > New project > Version Control > Git et cliquez sur "Create

Project".



™
New Project Wizard

Create Project

R New Directory

Start a project in a brand new working directory

| Existing Directory
M Associate a project with an existing working directory

Version Control

Checkout a project from a version control repository

Cancel

New Project Wizard

Back Create Project from Version Control

™

Clone a project from a Git repository

Subversion

Checkout a project from a Subversion repository

Cancel



New Project Wizard

Back Clone Git Repository

Repository URL:

| https://gitlab.huma-num.fr/dbelveze/introduction-git-et ‘

I+

Project directory name:

| introduction-git-et-gitlab ‘

Create project as subdirectory of:

|C:/’UsersXheutte_kXDesktopj’ARDoISEfR | Browse...

Open in new session

Create Project Cancel
NB : Prenez le bon lien en HTTPS dans gitlab !
.. introduction git et gitlab @
¥ main v introduction-git-et-gitlab / | + « Find file Edit v ‘ Code v ‘
Clone with SSH

4" mise a jour index site terminé avec numérotation des chapitres

damienbelveze authored 1hour ago git@gitlab.huma-nun.fr:dbelveze/ | [3 ‘

Clone with HTTPS

Name Last commit https://gitlab.huma-num.fr/dbelv | [

Le repo va se cloner a I'endroit de votre working directory paramétré dans Rstudio.

Pour le Token, allez sur le repo GitLab (en bas a gauche) dans "Settings" puis dans "Access tokens".
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Cliquer sur "Add new token"

Project access tokens

General

Integrations

Webhooks

Access tokens b
Repository

Merge requests

CI/CD

Packages and registries
Monitor

Usage Quotas

= AAkTT M

Generate project access tokens scoped to this project for your applications that need access to the GitLab API. You can also use project access tokens with Git to authenticate over

HTTP(S). Learn more.

Active project access tokens @ 1

Token Description Scopes
name

test_token api, read_api, create_runner, manage_runner, k8s_proxy, read_repository,
write_repository, read_registry, write_registry, read_observability,

write_observability, ai_features

Created Last @ Expires Role Action
Used
Feb 03, 6 days in 10 Owner inj
2026 ago hours
e
L

Choisir un nom pour le token, une description, sélectionner le role désiré et cocher les autorisations
puis cliquer sur "Create Project Access Token". Aprés validation, le token apparait : copiez-le car il ne

réapparaitra plus et il vous faudra en recréer un autre.



Project access tokens

Generate project access tokens scoped to this project for your applications that need access to the GitL
HTTP(S). Learn more.

Add a project access token

Token name

‘ vscodium_token

For example, the application using the token or the purpose of the token. Do not give sensitive inform:

Token description

Token pour VSCodium

Expiration date

2026-04-03 [ ] Eﬁ‘

Select a role

Owner v ‘

Select scopes
Scopes set the permission levels granted to the token. Learn more.

api

Grants complete read and write access to the scoped project API, including the container registry,

read_api
Grants read access to the scoped project API, including the Package Reqgistry.

Grants create access to the runners.

create_runner

manage_runner

Allez dans I'onglet "terminal” (a droite de I'onglet "Console") dans Rstudio. Puis entrez la ligne suivante

|git config credential.helper store

Puis

|git push https://gitlab.huma-num.fr/dbelveze/introduction-git-et-gitlab.git

Une fenétre de connection GitLab apparait :



Console  Terminal Background Jobs

Terminal 1 ~ | MINGW64:/c/Users/heutte_k/Desktop/ARDoISE/R/introduction-git-et-gitlab

heutte_k@uUC12180 MINGW6E4 ~/Desktop/ARDOISE/R/introduction-git-et-gitlab (main)
$ git config credential.helper store

heutte_k@uCl2180 MINGWE4 ~/Desktop/ARDOISE/R/introduction-git-et-gitlab (main)
$ git push https://gitlab.huma-num. fr/dbelveze/introduction-git-et-gitlab.git
warning: missing OAuth configuration for gitlab.huma-num.fr - see https://aka.ms/gcm/gitlab for more info

rmation

Connect to GitLab

GitLab

Signin
https://gitlab.huma-num.fr/

Token

[usemame o e optona) |

Remplissez les champs avec votre email lié au gitlab et votre token fraichement créé.



Connect to GitLab

GitLab
Sign in
https://gitlab.huma-num.fr/

Token

kiIian.heutte@univ-rennes&fﬂ

Via une clé SSH

Créer un nouveau projet dans Rstudio : File > New project > Version Control > Git et cliquez sur "Create
Project".



™
New Project Wizard

Create Project

R New Directory

Start a project in a brand new working directory

| Existing Directory
M Associate a project with an existing working directory

Version Control

Checkout a project from a version control repository

Cancel

New Project Wizard

Back Create Project from Version Control

™

Clone a project from a Git repository

Subversion

Checkout a project from a Subversion repository

Cancel



New Project Wizard

Back Clone Git Repository

Repository URL:

‘ git@gitlab.huma-num.fr.dbelveze/introduction-git-et-gi

I+

Project directory name:
: introductioh-git-et-gjtlab
Create project as subdirectory of:

‘ C:/Users/heutte_k/Desktop/ARDolSE/R Browse...

Open in new session Create Project Cancel

NB : Prenez le bon lien SSH!

.- introduction git et gitlab @

¥ main v introduction-git-et-gitlab / | 4+ ~ Find file Edit + ‘ Code ~ ‘
Clone with SSH
‘A mise a jour index site terminé avec numérotation des chapitres ] .
damienbelveze authored 1hour ago git@gitlab.huma-num.fr:dbelveze/ I?] ‘
Clone with HTTPS
Name Last commit https://gitlab.huma-num.fr/dbely | [

Le repo va se cloner a I'endroit de votre working directory paramétré dans Rstudio.

Aller sur Git Gui, Help > Show SSH Key

1:5 Git Gui (heutte k) C:/Users/heutte k
Repository Edit Branch Commit Merge Remote Tools Help

Current Branch: master About Git Gui -
Unstaged Changes Online Documentation
[0 .duckdb/extensions/extensions.duckdb.org/v1.2.2 /fwasm_eh/icu.c
[ .fog_user.log B ‘ [gui]
recentrepo

Cliquer sur "Generate Key", ne rien mettre dans passphrase et cliquer sur "OK".



& Your OpenSSH Public Key X

No keys found. Generate Key

Copy To Clipboard Close
Votre clé a été créée !

E-, Your OpenSSH Public Key X
Your key is in: ~/.ssh/id_rsa.pub Generate Key

ssh-rsa AAAAB3NzaC1yc2EAAAADAQABAAABgQDKIlizgVNWelOX2MvOfW
9QO5GFZIuTUQ1 /vjwHxG6G +dy2xbGP8PPMNB1MwVfAeF6DdhotrQucaAK

GunGNFyrl/MF3cZARGLD4LERAYiAAtgF +6ESAbs1aWxB3laMwMXhoMMcc

NVR3+w1InG3pS7TWCBUEFKUHB2sopK4UVUCvsyGLPBp +J8iEvrXIdtRNyT6s

RZG1iUAkGZz+R/1V0OvoNdcsce9lwe3LDsxLQrmStrMvYFLSzovgbudznTGofz
b19ynfjb3XiXPnL7A7RHkkW/YfmSebNZ79U4 +glu7ujo2pOICIcBhMB59dyT

0iRGt02dklLBtgfpoVOzlzz +8zssKEihmpwbolFtaBY4vB8czXyNdoRYa70UQVGA

+g19fusQbyVIGSnalYSIH85cNQMBFRtv/oqERkr6dxThEBFd +V2ADAx9uuN;j

whREalRBvQpXWyuqOSodxIMZ8NaUSpl7d2Ga19Ixokkg3UB9cQ4j3xbRW +j
YfGMDsPmIsMUI7B6s+)M= heutte_k@UC12180

éCopy To Clipboardé Close

Cliquez sur votre avatar en haut a gauche. Allez dans "edit profile" > SSH keys. Cliquer sur "add new
key".



H 0D+ & User Settings / SSH Keys
o n &

Search settings
Q Searchorgo to...

SSH Keys

User settings

SSH keys allow you to establish a secure connection between your computer and GitLab. SSH fingerprints verify that the client is connecting to the correct host. Check the current instance

@ Profile configuration.

8* Account

98 Applications Your SSH keys 21

3 chat Title Key Usage type Created Last used

@ Access tokens

adr2\heutte_k@UC12180 £ a3:76:08:6f:a2:82:45:61:40:ca:3d: 17:ba:al:91:a9 Authentication & Signing 6 days ago 1day ago
& Emails

A Notifications

| £ ssHkeys

Coller votre clé fraichement générée sur Git Gui dans le champ "Key" puis cliquer sur "Add key".

User Settings / SSH Keys

SSH Keys

SSH keys allow you to establish a secure connection between your computer and GitLab. SSH fingerprints verify that the client is connecting to the correct host. Check the curre

configuration.

Add an SSH key

Add an SSH key for secure access to GitLab. Learn more.

Key

LDsxLQrmStrMvYFLSzovgbudznTGofzb19ynfjb3XiXPnLZA7RHKKW/

ssh-rsa AAAAB3NzaClyc2EAAAADAQABAAABgGQDKIizZqYNWelOX2MvOfWIQOSGF ZJUTUQ1/VjwHXGEG +dy2xbGP8PPMNBIMwVfAeFEDdhotrQucaAKGUNGNFyri/
MF3cZ4RGLDALERAYiAAtqF+6ESAbs1aWxB3JaMwMXhoMMccNVR3+w1JnG3pS7WCBUEFKUHB2s0pK4UVUCYsyGLPBp+JBIEVrXIdtRNYT6SRZG1IUAKGZz+R/1VOvoNdcsce

YfmSe6NZ79U4+gJu7ujo2pOlClc8hMB59dyToiRGt02dkLBtgfpoV0zJzz +8zssKEihmpw6IFtaBY4v8czXyNdoRYa70UQVGA+g19fusQByVIGSnalY SIHB5cNQMBFRtv/
oqEerdeTbEBFd +V2ADAX9uUNjwWhREaIRBVQpXWyuqOSo4xIMZ8NaUSpl7d2Gal91xokkg3UB9cQ4j3xbRW+]YfGMDsPmIsMUI7BBs+JM= heutte_k@UC12180

Begins with 'ssh-rsa’, 'ecdsa-sha2-nistp256', 'ecdsa-sha2-nistp384', 'ecdsa-sha2-nistp521', 'ssh-ed25519', 'sk-ecdsa-sha2-nistp256@openssh.com’, or 'sk-ssh-

ed25519@openssh.com”.

Title

| heutte_k@UC12180 ‘

Key titles are publicly visible.

Usage type

| Authentication & Signing ‘

Expiration date

| 2027-03-04 [x N |

Optional but recommended. If set, key becomes invalid on the specified date.

Allez dans I'onglet "terminal” (a droite de lI'onglet "Console") dans Rstudio. Puis entrez la ligne suivante

(en remplacant I'exemple par votre adresse) :



(Top Level)

Console  Terminal Background Jobs

Terminal 1 ~ MINGW64:/c/Users/heutte_k/Documents

heutte_k@ucCl12180 MINGW64 ~/Documents (master)

$ git clone https://gitlab.huma-num.fr/dbelveze/jupyter_phd.git
Cloning into 'jupyter_phd'...

remote: Enumerating objects: 12978, done.

remote: Counting objects: 100% (117/117), done.

remote: Compressing objects: 100% (116/116), done.

remote: Total 12978 (delta 47), reused 0 (delta 0), pack-reused 12861 (fro
Receiving objects: 100% (12978/12978), 78.91 MiB | 4.10 MiB/s, done.
Resolving deltas: 100% (1485/1485), done.

Updating files: 100% (12710/12710), done.

heutte_k@uC12180 MINGW64 ~/Documents (master)

lhanitd+a LANHAT 3100 MTELIE A

$ git Eonfig ——g105a1 user.email "kilian.heutte@univ-rennes2.fr"

|git config --global user.email "Prénom.Nom@univ-rennes2.fr"

Conclusion

Retourner sur Rstudio. Modifier un fichier et I'enregistrer. Dans I'onglet "Git" (en haut a droite), faire
un commit

EY introduction-git-et-gitlab — R

Environment  History Connections Build Git Tutorial

B piff Commit  * Pull ~ 1 © o - %= man- C-
btaged  Status Path
[ M _gitignore

- M introduction-git-et-gitlab.Rproj

Cette fenétre s'affiche, cocher le ou les fichiers a commit et entrer un message. Une apparence
modifiée effectuée apparait en bas. Cliquer sur "Commit".



. RStudio: Review Changes

Changes History — main ~ ¥ Stage = © Revert Ignore @ pul | # push
Staged  Status “ Path Commit message 25 characters
@ .gitignore Modification du README.md
(M)

[@ introduction-git-et-gitlab.Rproj

Amend previous commit Commit

Show @ staged O Unstaged  Context | Slines v/ Ignore Whitespace | Unstage All
um. 11 JpreseiedL v )

all

16 Gitlab est une forge logicielle s'appuyant sur Git et proposant différents services comme le suivi de tickets,
des wikis, et un systéme d'intégration continue.

17

18 Toutes Tes ressources présentées lors de Ta formation doctorale sont disponibles dans ce repo.

No newline at end of file

title: "s'initier a Git et a 1a forge GitLab"

author: "Damien Belvéze"

date: Tast-modified

N O v W N

Ce support a été congcu pour initier des doctorant.e.s a 1'usage de 1'outil de contrdle de version Git et de la
forge Gitlab.

co

9 1I1 est recommandé aux doctorant.e.s d'installer Git sur leur machine avant la séance et de se créer un compte
sur 1'une des forges a leur disposition.
10 Selon leur discipline :
11 - aitlab héberaé par Huma-Num pour les Lettres Sciences Humaines et Sociales v

Un console git Commit apparait. Cliquer sur "Close".

Faire un "push" depuis le menu commit ou depuis I'onglet git pour synchroniser les changements.

. RStudio: Review Changes

Changes History  main ~ & pull

@ Your branch is ahead of 'origin/main’ by 1 commit. Commit message
itaged Status = Path

[@ .gitignore

[@ introduction-git-et-gitlab.Rproj

Amend previous commit Commit

Show @ Staged O Unstaged Context | 5lines | Ignore Whitespace * Unstage All



EY introduction-git-et-gitiab — R

Environment  History  Connections Build Git Tutorial
Q ~ B piff Commit =+ Pull ~ 1 ® - %=  man -  C
Staged Status Path
[ M _gitignore
- M introduction-git-et-gitlab.Rproj




